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Introduction  

The PROM File Formatter provides a graphical user interface that 
allows you to format BIT files into a PROM file compatible with 
Xilinx and third-party PROM programmers. It is also used to 
concatenate multiple bitstreams into a single PROM file for daisy 
chain applications. In addition, the PROM File Formatter enables you 
to take advantage of the Xilinx FPGA reconfiguration capability, as 
you can store several applications in the same PROM file. 

PROM files are also compatible with the Hardware Debugger. You 
can therefore use the Hardware Debugger to download a PROM file 
to a single FPGA or to a daisy chain of FPGA devices. 

The PROM File Formatter replaces the MakePROM program on the 
PC. MakePROM can be used to format PROM files on a workstation. 

What Is a Xilinx PROM File?
A Xilinx PROM file consists of one or more data streams. In this 
context, a data stream represents all the configuration data required 
to implement a given application. Each data stream contains one or 
more BIT files and once saved, will have a separate preamble and 
length count. Figure 1-2 illustrates the structure of a PROM file. 

The PROM file can be formatted in one of three industry standard 
formats: Intel MCS-86, Tektronix TEKHEX, and Motorola EXORmacs. 

Note: You can also format BIT files into a HEX format file. This file 
type is not considered a PROM file since you cannot use it to program 
PROM devices. A HEX format file is ordinarily used as input to user-
defined processes or programs. 

You can store PROM files in PROM devices or on your computer. In 
turn, you can use the files to program your FPGA devices either from 
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a PROM device on your board or from your computer using a serial 
or parallel cable. Refer to your Development System User Guide for 
more information.

Configuration Data Stream Box
The Configuration Data Stream box, or workspace in the PROM File 
Formatter window, represents the structure of your PROM file. It 
consists of one or more data streams.

● A data stream consisting of one BIT file contains data to configure 
a single device. 

● A data stream consisting of more than one BIT file contains data to 
configure a group of devices connected in daisy chain fashion. 

The PROM File Formatter uses horizontal arrows to indicate the 
relationships between files in a single data stream. Each arrow 
represents a link in the configuration bitstream to the next device in 
the chain. 

Before programming a daisy chain of FPGA devices, you must first 
concatenate the configuration BIT files together. Each BIT file 
corresponds to an FPGA in the daisy chain.

The following figure exemplifies the structure of a typical PROM file 
designed to configure a single daisy chain of devices in master mode. 
Data Stream #1 configures a daisy chain of two devices. Data Stream 
#2 reconfigures the same daisy chain. 
1-2 Xilinx Development System
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Figure 1-1 Reconfiguration Data Streams

Implementing Your Applications
A PROM file contains data to configure one FPGA device, or one or 
more groups of FPGA devices concatenated in daisy chain fashion. 
The PROM file also takes advantage of the Xilinx SRAM-based 
FPGA’s unique logic reconfiguration capability, as it allows you to 
store different data streams corresponding to different applications in 
the same file. 

The following table summarizes the various ways of structuring a 
PROM file. 

Data Stream #1

Data Stream #2
PROM File Formatter Reference/User Guide 1-3
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Table 1-1  Configuration Data Stream Combinations

The following figure exemplifies the structure of a byte-wide PROM 
file loaded in master mode and designed to configure three daisy 
chains of devices. Data Stream #1 is for a daisy chain of two devices. 
Data Stream #2 is for a second daisy chain of two devices. Data 
Stream #3 is for a single device.

a. This type of application can be implemented with a byte-wide PROM only. Each data stream will use a
different start-up address in the PROM file. 

Number of 
Applications

Number of FPGA 
Devices to 
Configure

Number of Data Streams and BIT files

Single Application Single device One data stream with a single BIT file.

Daisy chain of devices One data stream with multiple BIT files.

Multiple daisy chains 
of devicesa

Multiple data streams with multiple BIT 
files in each data stream. Each data 
stream includes configuration data for a 
different daisy chain of devices. 

Multiple Applications Single device Multiple data streams with a single BIT 
file in each data stream.

Daisy chain of devices Multiple data streams with multiple BIT 
files in each data stream. Each data 
stream represents a different applica-
tion.
1-4 Xilinx Development System
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Figure 1-2 Configuration Data Streams for Multiple Daisy Chains

Single Application PROM Files
There are three different types of configuration data streams. 

● To implement an application for a single device, use a data stream 
containing a single BIT file. Data Stream #3 in Figure 1-2 shows a 
configuration data stream for a single device.

● To implement an application for a group of FPGA devices 
connected together in a daisy chain, use a single data stream 
containing multiple BIT files, that is, one BIT file for each device in 
the daisy chain. Data Stream #2 in Figure 1-2 shows a 
configuration data stream for a single daisy chain of devices.

● To implement an application for several groups of daisy chained 
devices, you must build one data stream per daisy chain.
Figure 1-2 is an example of a PROM file for multiple daisy chains 

Data Stream #1

Data Stream #2

PROM File Components

Data Stream #3

BIT file #2

BIT file #1
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of devices. This type of implementation is valid for byte-wide 
PROMs only, which can be set for different start-up addresses.

Multiple Application PROM Files
The Xilinx SRAM FPGA technology allows you to design multiple 
applications for a single device or for a set of devices. Each data 
stream in the PROM File Formatter Configuration Data Stream box 
represents a different configuration or application for the same device 
or daisy chain of devices. 

To implement several applications for a single device, build a PROM 
file made of several data streams. In this case, each data stream 
contains a single BIT file. To implement several applications for a 
group of daisy chained devices, use several data streams containing 
multiple BIT files. Each data stream programs the group of devices 
for a different application. 

Note: The number of BIT files within each data stream must be the 
same. 

Refer to Figure 1-1 for an example of a PROM file designed for 
multiple applications. In this figure, Data Stream #1 configures the 
daisy chain of devices with the “Slow” application. Data Stream #2 
configures the same daisy chain with the “Fast” application. You can 
easily switch to the next application by reprogramming the FPGA 
from a PROM file formatted for multiple applications. 

Configuration Setups
For information on setups for configuring FPGA devices and daisy 
chains for a single application, refer to The Programmable Logic Data 
Book. For information on setups to support multiple applications, see 
the “Multiple Configuration Setups” appendix. 
1-6 Xilinx Development System
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Getting Started  

This chapter explains how to invoke the PROM File Formatter. It 
describes the main screen and the three major tasks you can perform: 
create, save, and split PROM files. In addition, it outlines the features 
of the online help tool. 

Starting and Exiting the PROM File Formatter
The PROM File Formatter is a Windows-based application that can be 
accessed two ways. 

● To use the PROM File Formatter from within the Xilinx Design 
Manager, press the PROM File Formatter button, shown in 
Figure 2-1, in the toolbox of that program.

Figure 2-1 PROM File Formatter Button

● If you installed the PROM File Formatter as a stand-alone tool, the 
PROM File Formatter icon is in the XACTstep program group in 
the Program Manager window. To invoke the PROM File 
Formatter, double-click on the PROM File Formatter icon in the 
XACTstep program group. For information on how to create 
program icons, refer to your Getting Started &Installation Guide.

To exit the PROM File Formatter, select File ➝ Exit from the 
menu bar.
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Using the PROM File Formatter Interface
The PROM File Formatter consists of the elements described in this 
section.

Main Window
The PROM File Formatter Main Window, shown in Figure 2-2, is 
displayed when you invoke the PROM File Formatter. By default, the 
main window displays a workspace, a menu bar, a toolbar, and a 
status bar. You can hide the toolbar and the status bar by toggling the 
Toolbar or Status Bar entries from the View menu. 

Figure 2-2 PROM File Formatter Main Window

Workspace

The workspace, shown in the previous figure, is used to create and 
format one or more BIT files into a PROM file. It consists of the 
Configuration Data Stream area, selection boxes, and command 
buttons. 

Data Stream for

Data Stream for 

Status Bar

Menu Bar

Toolbar

Workspace

single device

daisy chain
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Menu Bar

The menu bar is located at the top of the PROM File Formatter 
window. It includes the File, Edit, View, and Help menus. You can 
also select menu commands by typing the letter underlined in the 
menu command while pressing the Alt key down. Refer to the 
chapter titled “Command Reference” for information on the menu 
commands. 

Toolbar

The toolbar is located at the top of the screen below the menu bar. It 
displays several buttons, which you can use to specify commands 
directly. The toolbar offers an alternative to the menu commands. To 
get a short description of a toolbar button, park the mouse pointer 
over the button. After about 2 seconds, a small pop-up text box 
appears giving more information about that button. This button is 
called Tool Tips. The Tool Tips utility displays the name of the button 
function while the status bar repeats the information. 

Figure 2-3 New Toolbar Button

The New button clears data from the Configuration Data Stream 
screen, allowing you to build a new PROM file.

Figure 2-4 Save PROM Toolbar Button

The Save PROM button displays a dialog box that allows you to 
define the PROM file settings and save the current data. 

Figure 2-5 Split PROM Toolbar Button
PROM File Formatter Reference/User Guide 2-3
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The Split PROM button displays the Split PROM dialog box that 
allows you to split PROM files across multiple serial PROMs. 

Figure 2-6 Help Toolbar Button

The Help button invokes context-sensitive help.

Status Bar

The status bar is located at the bottom of the PROM File Formatter 
window. It provides command and processing status information as 
well as additional help information about the toolbar buttons. 

Commands and Dialog Boxes
You control the PROM File Formatter by selecting commands from 
the menu or the toolbar. Most commands display dialog boxes on 
which you specify information and options. 

All dialog boxes have an OK button and a Cancel button. Moreover, 
most dialog boxes also have a Help button and some have a Network 
button provided you are using Windows for Workgroups. 

● Click on the OK button to exit the dialog box and process the 
information defined on the dialog box. 

● Click on the Cancel button to exit the dialog box without 
processing the information defined on the dialog box.

● Click on the Help button to get context-sensitive help for the 
current dialog box.

● Click on the Network button to access your network drives. This 
button is available on Windows for Workgroups installations only. 

Selecting Commands and Dialog Box Options
To choose a menu item, a toolbar button, or a dialog box option, you 
can use the mouse or the keyboard.
2-4 Xilinx Development System
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Using the Mouse 

1. Move the mouse cursor over the object you want to select: a 
toolbar button, a menu option, or a dialog box option; then, click 
on the left mouse button to select the object.

If you clicked on a toolbar button, a list box or a dialog box 
appears. If you clicked on a menu, menu options are displayed 
and you must select a menu option. 

2. To cancel out of a dialog box without selecting anything, select the 
Cancel button or double-click on the upper left corner of the 
dialog box. 

3. To get help, click on the Help button on the dialog box. 

Using the Keyboard

You can use the keyboard to select objects on your screen, such as a 
dialog box button or a menu option. 

1. To select a dialog box option, use the Tab key to position the 
cursor on that object and highlight it. Press the Enter key to 
process the selection. 

To cancel out of a dialog box without selecting anything, press the 
Escape key. 

2. To choose a menu and display its options, press the Alt key and 
the appropriate underlined letter key corresponding to the menu 
you want. For example press Alt-F to select the File menu. 

3. Use the arrow keys to scroll down the list of options in a menu or 
list box. Press Enter when the option you want to use is 
highlighted or, in the case of a menu item, press the underlined 
letter corresponding to the menu option you want. For example, 
press the N key to select the New command of the File menu.

4. To get help, press the Alt key down and type the letter H. 

Software Operations
You use the PROM File Formatter to create, save, and split PROM 
files for use with a PROM programmer. 
PROM File Formatter Reference/User Guide 2-5



 

PROM File Formatter Reference/User Guide

        
Creating a New PROM File
When you open the PROM File Formatter, the PROM File Formatter 
main window is displayed. This window is the workspace in which 
you create and format your PROM files.

Figure 2-7 PROM File Formatter Main Window

The workspace includes the Configuration Data Stream box in which 
you create data streams. When you start up the program, the 
Configuration Data Stream box includes an empty data stream. When 
you add files to the data stream, the concatenation of files is indicated 
by horizontal arrows.

The right side of the screen lists the Directories, Drives, and BIT Files 
list boxes that you use to locate and select BIT files. 

● Drives list box

Click on this box to browse and select the drive from which you 
wish to load the BIT files. 

● Directories list box

Click on this box to browse the directory structure and locate the 
directory that contains the BIT files you want to open.

Drives 

Directories

BIT files
list box

list box

list box
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● BIT Files list box

Click on this box to locate and select the BIT files that you wish to 
concatenate into the data stream. To select the BIT file, double-
click on the file you want with the left mouse button or press the 
Enter key.

The lower part of the window includes four command buttons that 
you can use to build the stream of data. 

● Use the Add button and the Delete button in the BIT Files group 
box to insert and remove BIT files. 

● Use the New button and the Delete button in the Data Stream 
group box to insert and remove data streams.

Refer to the chapter, “Formatting Files,” for more information.

Saving a PROM File
After creating and editing your PROM file, select the Save PROM 
option from the File menu. The Save PROM dialog box is displayed. 
Complete this dialog with the appropriate settings, such as PROM 
type and file format, then save the file.

Figure 2-8 Save PROM Dialog Box
PROM File Formatter Reference/User Guide 2-7
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Refer to the chapter, “Formatting Files,” for more information.

Splitting a PROM File
To split an existing PROM file, select File ➝ Split PROM from the 
menu bar. An Open File dialog box is displayed, allowing you to 
select the file to be split. After you click on the OK button, the 
Split PROM File dialog box is displayed. Use this dialog box to split a 
large PROM file into smaller PROM files for specific PROM devices. 
The input file must be a serial PROM file in either the MCS-86, the 
TEKHEX, or the EXORmacs format. Refer to the chapter, 
“Reformatting Files,” for more information.

Figure 2-9 Split PROM File Dialog Box
2-8 Xilinx Development System
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Using the Online Help and Tutorial
The PROM File Formatter includes an online help tool that you can 
invoke from the menu bar, the toolbar, and the dialog boxes. It also 
includes an online tutorial that demonstrates the program features. 

Online Help
You can access the online help home page by selecting Contents from 
the Help menu.

Context-sensitive help refers to the online help available from a 
dialog box that you are currently using, the help available for a menu 
command, or the help available for a screen object.

● To get context-sensitive help for the current dialog box, either 
click on the dialog box Help button or press down the Alt key 
while typing the letter H on your keyboard. 

● To get context-sensitive help for a menu item, press the F1 
function key on your keyboard while selecting the menu item. 

● To get help on a screen object, namely a window, a part of the 
screen, a toolbar or control panel button, click on the Help icon 
displayed on the toolbar. The mouse cursor changes to a large 
question mark that you can drag onto the object you want. After 
positioning the symbol on the appropriate object, press the left 
mouse button. The help tool displays the corresponding Help 
page. 

Figure 2-10 Help Button

Online Tutorial
To access the online tutorial, select Tutorial from the Help menu. The 
tutorial page is displayed. Follow the instructions on your screen to 
view definitions, procedures, and demonstrations of the procedures. 
PROM File Formatter Reference/User Guide 2-9



PROM File Formatter Reference/User Guide
2-10 Xilinx Development System



Chapter 3
PROM File Formatter Reference/User Guide — 0401324 01 3-1

Formatting PROM Files  

This chapter explains how to configure one or more BIT files into a 
PROM file and how to define and save your PROM file settings.

Creating a PROM File
Creating a PROM file consists of adding BIT files and data streams to 
the Configuration Data Streams box in your workspace. A data 
stream can contain one or more BIT files. A data stream that contains 
multiple files is referred to as a daisy chain. Each data stream has a 
separate header that specifies the length of that data stream. 

After you add a file to a data stream, the approximate size of that data 
stream is displayed on top of the data stream frame and is preceded 
by a tilde sign (~). The exact size is displayed only when you save the 
PROM file. 

Using the PROM File Formatter Main Window
From the PROM File Formatter main window, you can use the 
following list boxes:

Drives List Box

Click on this box to browse and select the drive from which you wish 
to load the BIT files. 

Directories List Box

Click on this box to browse the directory structure and locate the 
directory that contains the BIT files you want to open.
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BIT Files List Box

Click on this box to select the BIT files that you are adding to the data 
stream. To select the BIT file, double-click once on the file with the left 
mouse button.

Figure 3-1 PROM File Formatter Main Window

To add and delete objects from the data stream, you can use the 
following buttons located at the bottom of the PROM File Formatter 
main window:

BIT File Buttons

● Add button: This button adds the selected BIT file after the 
currently selected BIT file in the current data stream. To add the 
file, you can also double-click on the File or press the Enter key. 

● Delete button: This button deletes the selected BIT file from the 
current data stream.

1. Select a 

2. Select a 

3. Select one

4. Click on Add button 

5. The Data Stream 

6. Click on New button to insert a

box is updated with
the new BIT file.

to insert the selected
BIT file in the data
stream window after 
the selecetd bitstream.

new data stream after the current
data stream.

drive.

directory.

BIT file by
clicking the
left mouse 
button once
on the BIT 
file.
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Data Stream Buttons

● New button: This button adds a data stream after the current data 
stream.

● Delete button: This button deletes the current data stream.

Building the PROM File
To build the PROM file, add BIT files to the data streams in the 
Configuration Data Stream box. 

Adding a BIT File to an Existing Data Stream

When you add a BIT file, the new BIT file is added after the currently 
selected BIT file in the current data stream. If no BIT file is selected in 
the current data stream, the new BIT file is appended at the end of the 
current data stream. 

1. To add a BIT file to a data stream, select a BIT file from the file 
browser using the drive and directory boxes to locate the file. 

You can only select one BIT file at a time. 

2. Click on the Add button in the BIT File box at the bottom of the 
screen to add the selected file to the data stream. Alternatively, 
you can double-click on the file name in the BIT Files list box to 
add the BIT file. 

3. Repeat steps 1 and 2 until you have added all the files you want 
for your daisy chain application. 

Adding a New Data Stream

When you add a data stream, the new data stream is placed either 
after the currently selected data stream. This button is disabled if no 
data stream is selected. 

1. To add a data stream after a specific data stream, click in the 
desired data stream window to select the data stream. 

2. Click on the Data Stream New button. 

The PROM File Formatter inserts an empty data stream after the 
selected data stream.
PROM File Formatter Reference/User Guide 3-3
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Note: To delete a data stream or a BIT file, select the appropriate 
object and press the Delete key on your keyboard or the appropriate 
Delete button at the bottom of the screen.

Editing the PROM File or Data Stream
After building a data stream, you can edit it by adding and deleting 
files or changing the sequence of the files in your data stream. You can 
add and delete data streams as well as change their sequence. 

Note: The cut and paste functions described below have separate 
clipboards for the BIT files and the data streams. This feature allows 
you to store a BIT file and a data stream at the same time. 

Editing a Data Stream

To change the order or number of BIT files in a data stream, follow 
these instructions. 

1. Select a file within the data stream by clicking on it with the left 
mouse button. Alternatively, you can use the left and right arrow 
keys to navigate within a data stream. Use the Up and Down 
arrow keys to move from one data stream to another. 

2. To add a file after the selected file, select a BIT file from the BIT 
Files list box and click on the Add button in the BIT Files group 
box or double-click the left mouse button on the BIT file.

3. To delete the currently selected BIT file in your data stream, click 
on the Delete button.

4. To remove the selected file from your data stream and temporarily 
store it on the clipboard, select the Cut File option from the Edit 
menu. 

5. To paste the file you stored on the clipboard into your data stream 
after or before the selected file, select Paste File from the Edit 
menu, then select the desired Paste File option: Before 
Selected file or After Selected file. 
3-4 Xilinx Development System
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Editing Multiple Data Streams

To change the order or number of data streams in the Configuration 
Data Streams box, follow these instructions.

1. Select a data stream on your screen by clicking on it with the left 
mouse button. 

2. To add an empty data stream after the selected data stream, click 
on the New button in the Data Stream group box. 

3. To delete the currently selected data stream, click on the Delete 
button in the Data Stream group box.

4. To remove the selected data stream from your screen and 
temporarily store it on the clipboard, select the Cut Data 
Stream option from the Edit menu. 

5. To paste the data stream stored on the clipboard after or before the 
selected data stream, select Paste Data Stream from the Edit 
menu, then select the desired Paste Data Stream option: Before 
Selected data stream or After Selected data stream. 

Saving the PROM File 
After creating the configuration bitstream, select the Save PROM 
command from the File menu to save the PROM file. The Save PROM 
dialog box appears. Use this dialog box to select and save the 
attributes of your PROM file, namely, its format, size, starting address 
(byte wide PROMs only), and name. 

Note: The device type and size information is provided for error-
checking purposes, enabling you to check whether the file fits the 
device you are targeting. This information is not saved to the file.
PROM File Formatter Reference/User Guide 3-5
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Figure 3-2 Save PROM Dialog Box 

Completing the Save PROM Dialog Box
Xilinx recommends that you first decide which PROM type and 
which PROM file format you will be using. Some PROM formats 
support larger file sizes than others. The following table shows the 
capacity of each of the PROM formats supported by the PROM File 
Formatter. 

Table 3-1  PROM Formats and Sizes 

a. This size applies to the Up loading direction only. The Down loading direction
is limited to 64 K. 

Format
Number of Addresses 

(Bytes)
Total Number of 

Bits

TEKHEX        65,536        524,288
MCS-86   1,048,576a     8,388,608
EXORmacs 16,777,216 134,217,728
HEX   No limit     No limit

Sets the format to be Sets the specific 

 

Invokes the Byte

Invokes the 

Saves the current 
.

used when saving 
the PROM file.

settings.

PROM to be 
used..

Wide Detailed 
Setup dialog box.

Browse dialog 
box to specify 
where to save 
the PROM file. 
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PROM Type Radio Button

By default, the Serial radio button is selected. If you are targeting byte 
wide PROMs, click on the Byte Wide radio button. Xilinx PROMs are 
serial devices. 

File Format List Box

Click on the down arrow to the right of the File Format list box to 
view the available formats: TEKHEX, MCS-86, EXORmacs, and HEX. 
If you choose a format that does not support the size of your PROM 
file, the message box shown in Figure 3-3 is displayed. In this case, 
you must return to the Save PROM screen and select a different 
PROM format. The message box tells you the valid formats available 
for your data size.

Figure 3-3 Inadequate Format Message Box

PROM Size List Box

Click on the down arrow to the right of the PROM Size list box to 
view available device sizes. The list displays the sizes for either serial 
or byte wide PROMs depending on the PROM Type selected. The 
PROM File Formatter automatically selects the smallest single device 
PROM size that fits.

If you select a serial PROM type smaller than necessary to hold the 
PROM data, the PROM File Formatter prompts you to either select a 
larger PROM or to split the data across multiple PROMs using the 
Split PROM function. See Figure 3-4.
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Figure 3-4 Invalid PROM Size Message Box

If none of the available PROM sizes fit your device, a message box 
prompts you to split the PROM file.

Starting Address and Loading Direction Boxes

These options are available if you select the byte wide PROM type. To 
change the starting address and loading direction of your byte wide 
PROM file, edit the Starting Address field. To select the loading 
direction you want, use the Loading Direction pull-down list box.

If you click on the Advanced button, the Byte Wide PROM Detailed 
Setup dialog box is displayed. See Figure 3-5. This dialog box enables 
you to set the Starting Address and Loading Direction for each data 
stream in your PROM file. Select the data stream in the dialog box to 
change either parameter for that data stream.
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Figure 3-5 Byte Wide Detailed Setup Dialog Box

File Name Box

To change the file name, enter a new file name in the File Name box. 
To change the disk drive and directory, or to select an existing file 
name, click on the Browse button. The Browse command displays the 
Browse dialog box. The Browse dialog box allows you to change the 
file name, directory, and drive to which the file will be saved.
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Figure 3-6 Browse Dialog Box

Saving a PROM File for a Serial PROM
To save a PROM file for a serial PROM device, follow these 
instructions: 

1. Select Save PROM from the File menu or click on the toolbar 
Save PROM button.

Figure 3-7 Save PROM Toolbar Button

The Save PROM dialog box is displayed as shown in Figure 3-8. 

2. Check that the Serial radio button is selected in the Save PROM 
dialog box. This button is selected by default. 

3. Choose a PROM file format compatible with your PROM 
programmer by clicking on the down arrow in the File Format list 
box.

4. Click on the down arrow of the PROM Size list box to view 
available device sizes and select a device size that fits your data 
file.

Note: The PROM File Formatter automatically selects the smallest 
PROM that can contain the data file. 
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If you select a serial PROM type smaller than necessary to hold 
the PROM data, the PROM File Formatter prompts you to either 
select a larger PROM or to split the data across multiple PROMs 
using the Split PROM function. 

Figure 3-8 Save PROM Dialog Box (Serial PROM) 

5. To change the design file name, click on the File Name box of 
the Save PROM dialog box and type in a new name. 

To use an existing file name or to save to a different path, click on 
Browse. This selection displays the Browse dialog box. 

6. Click on the OK button to save the PROM data. 

Saving a PROM File for a Byte Wide PROM
To save a PROM file for a byte-wide PROM device, follow these 
instructions: 

1. Select Save PROM from the File menu or click on the Save PROM 
toolbar button to display the Save PROM dialog box.
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Figure 3-9 Save PROM Toolbar Button

2. Click on the Byte Wide radio button in the Save PROM dialog 
box.

3. Choose a PROM file format compatible with your PROM 
programmer by clicking on the down-arrow in the File format list 
box. 

4. Click on the down arrow of the PROM Size list box to view 
available device sizes and select a device size that can fit your data 
file. 

The PROM File Formatter displays only PROM sizes with 
sufficient capacity to hold the PROM data.

Figure 3-10 Save PROM Dialog Box (Byte Wide PROM)

5. To change the direction in which the data is stored in the PROM:

● Choose the Up direction if you want to store the data starting 
at a low address and load it in the upward direction. 
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● Choose the Down direction, if you want to store the data 
starting at a high address and load it in the downward 
direction. 

6. To set different starting addresses for your data streams, click on 
the Advanced button using the left mouse button and edit the 
starting address for each data stream in the PROM file. Make sure 
the addresses do not overlap.

Figure 3-11 Changing the Starting Address of a Data Stream

After clicking on the Apply button, the Start and End addresses of 
the current data stream and those of subsequent data streams 
loaded in the same direction are updated. 

1. Select Data 
Stream 1.

2. Edit the Starting
Address field
Replace the current
value with 0000 1000.

3. Click on the Apply 
button to update the
addresses of the 
selected data stream 
and subsequent ones.
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Figure 3-12 Updating the Data Stream Starting Addresses 

7. To change the design file name, click OK to return to the Save 
PROM window, then click in the File Name box of the Save 
PROM window and type in a new name. 

To use an existing file name or to save to a different path, click on 
Browse. This selection displays the Browse dialog box. 

8. Click on the OK button to save the PROM data. 

Note that the 
addresses of data
streams 1, 2, and 3
have been updated
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Reformatting PROM Files  

This chapter addresses how to reformat an existing PROM file into 
smaller files to fit it into multiple serial PROM devices. You can use 
the Split PROM command to split PROM files. 

Splitting PROM Files
You can retarget existing MCS, EXO, or TEK files to multiple serial 
PROM devices by splitting your PROM file into smaller files. To split 
a large file that you are attempting to save into multiple serial PROM 
files, refer to the procedure “Splitting the Current Data into Multiple 
PROM files,” later in this chapter. You can only target serial PROMs 
when splitting a PROM file, whether the original file is in serial or 
byte wide format. 

Using the Split PROM Dialog to Retarget a PROM File 
Use the Split PROM dialog box to retarget a PROM file to multiple 
serial PROM devices. There are two ways of accessing the Split 
PROM dialog box to retarget a PROM file:

● If you want to retarget an existing PROM file, select the Split 
PROM option immediately after invoking the PROM File 
Formatter. This option invokes a file selection dialog box from 
which you select the file to be split. 

● If you try to save a PROM file into a PROM device that is too 
small, an error message box appears. When you select the Split 
PROM option from this message box, the Split PROM dialog box 
is displayed. 

Note: You can only retarget MCS, TEK, and EXO file formats. You 
cannot retarget a HEX file because you cannot use this format to 
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program a PROM device. Use HEX files for user-defined processes or 
programs. 

Splitting the Current Data into Multiple PROM Files
You may need to reformat the current data file that you are 
attempting to save into smaller files that fit into your PROM devices 
by retargeting the file to multiple serial PROMs. 

1. After selecting the appropriate BIT files for the desired data 
streams, select the Save PROM command from the File menu.   

2. Select the Serial radio button in the PROM Type group box.

3. Select a serial PROM size smaller than adequate to hold the PROM 
data. This selection causes the Invalid PROM Size dialog box to 
appear, allowing you to select the Split PROM function. 

Figure 4-1 Invalid PROM Size Dialog Box

4. Click on the Split PROM button in the Invalid PROM Size dialog 
box and follow the instructions for retargeting a PROM file to 
multiple serial PROMs. 

Retargeting an Existing PROM File to Multiple Serial 
PROMs

You can use the PROM File Formatter to retarget existing MCS, EXO, 
or TEK files to multiple serial PROM devices by splitting your PROM 
file into smaller files. 
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1. Select the Split PROM command from the File menu or click on 
the toolbar Split PROM button to display a file selection dialog 
box in which you specify the PROM file.

Figure 4-2 Split PROM Toolbar Button

After opening the selected file, the PROM File Formatter displays 
the Split PROM File dialog box, shown in Figure 4-3. 

Figure 4-3 Split PROM File Dialog Box

The Status box, at the top of the dialog box, provides information 
on the status of the current PROM file allocation.

1. Assess the size of the

2. Highlight a device if 

4. Click on the Add 

2. Select a method for

    file to split

    selecting devices. 

    you chose selection 
    method 1 or 3.

   devices.

   button to move the
   selected device to 
   the list of added 
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● The Total Number of Bytes box indicates the size of the PROM 
file you are splitting or total number of bytes to be allocated. 

● The Bytes Filled Up box indicates the number of bytes already 
allocated to a device. 

● The Bytes Left box indicates the number of bytes that still need 
to be allocated. 

2. Click on the radio button for one of the following device selection 
methods and select the devices you need from the serial PROM 
list, in the left-hand side list box. This list provides the PROM 
name and PROM size expressed in bytes. 

● Add Selected Device: Adds one instance of the device type that 
you select in the Device list box. To complete this operation, 
select a device type in the left-hand side device list box column 
and click on the Add button. 

● Complete Using All Devices: Automatically selects the 
minimum number of serial PROMs required to contain the 
data. To complete this operation, click on the Add button.

● Complete Using Selected Device: Adds the appropriate 
number of devices of the type you select in the Device list box. 
To complete this operation, you must also select a device type 
in the left-hand side column and click on the Add button.

After you click on the Add button, the selected PROM devices are 
moved to the right-hand side Device list box, which displays the 
target PROMs in the order in which the PROM file is to be split. 

Note: After creating a list of devices, you can edit that list by 
removing devices from the right-hand side column or by adding 
devices using any of the above device selection methods. 

Each file is assigned a default file name in the form of an 
appended _1, _2, ... suffix to the first five characters of the input 
file name. For example, if the original file name is design.mcs and 
the PROM file is split into three smaller PROM files, they will be 
named as follows: design_1.mcs, design_2.mcs, and design_3.mcs. 

3. To change the name of one of the split files, select a PROM part 
number in the right-hand side Device list box and edit the entry 
displayed in the Change File Name text box. 
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4. After editing the file name, click on the Apply button. 

The new name appears next to the part number. 

5. Click on the Save button to split the PROM file using the settings 
you just defined. The Save button is grayed out and cannot be 
used until you have allocated all the bytes of your PROM file. 

When you click on the Save button, the split files and a PDR 
report file are saved in the design directory. The PDR report lists 
all the data streams and BIT files used to construct the PROM file 
as well as the load direction and PROM file splitting information.
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Menu Command Reference  

This chapter lists and describes all the commands available in the 
main window of the PROM File Formatter. The commands are listed 
in alphabetical order. When applicable, the corresponding toolbar 
button is included in the command description. 

Menus
The PROM File Formatter has four menus, which are described in the 
following sections. 

File Menu
The File menu contains commands to clear data from the main 
screen, save the PROM file, split the PROM file, and exit the PROM 
File Formatter. To access the File menu with the keyboard, press the 
letter F, underlined in the menu name, while holding down the Alt 
key. Press the underlined letter corresponding to the menu option 
you want. The commands on the File menu are the following:

New Clears the data from the configuration 
screen.

Save PROM Saves the current PROM file.
Split PROM Prompts you for the file to split then

opens the Split PROM dialog box.
Exit Exits the PROM File Formatter 

program.
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Edit Menu
The Edit menu includes commands to cut and paste files and data 
streams in the Configuration Data Stream box. To access the Edit 
menu with the keyboard, press the letter E, underlined in the menu 
name, while holding down the Alt key. Press the underlined letter 
corresponding to the menu option you want. 

Cut File Cuts the selected BIT file and
stores it on the BIT file clipboard.

Cut Data Stream Cuts the selected data stream and
stores it on the data stream clipboard.

Paste File Inserts the file stored on the BIT file 
clipboard in the data stream.

Paste Data Stream Inserts the data stream stored on the
data stream clipboard.

View Menu
The View menu includes commands to display special screen areas, 
and customize the waveform. To access the File menu with the 
keyboard, press the letter V, underlined in the menu name, while 
holding down the Alt key. Press the underlined letter corresponding 
to the menu option you want. 

Toolbar Toggles the toolbar on or off.
Status Bar Toggles the status bar on or off.

Help Menu
The Help menu contains commands that enable you to access online 
help for the Hardware Debugger. To access the File menu with the 
keyboard, press the letter H, underlined in the menu name, while 
holding down the Alt key. Press the underlined letter corresponding 
to the menu option you want. 

Contents Lists online help topics.
Search for Help On Searches for specific topics.
Tutorial Invokes the interactive tutorial.
About PROM File Formatter Displays the program version.
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Alphabetical Listing of Commands
The following commands are available in the menus of the PROM 
File Fomatter’s graphical user interface. 

About PROM File Formatter (Help Menu)
Use this option to display information about the version number of 
the PROM File Formatter. 

Contents (Help Menu)
Use this option to display a dialog box that lists the contents of the 
Help facility.  

Figure 5-1 Help Toolbar Button

Double-click on the Help toolbar button to display the Contents page 
of the Help facility. To get help on a screen object, namely a window, a 
part of the screen, a toolbar or control panel button, click on the Help 
icon displayed on the toolbar. The mouse cursor changes to a large 
question mark that you can drag onto the object you want. After 
positioning the symbol on the appropriate object, press the left mouse 
button. The help tool displays the corresponding Help page.

Cut Data Stream (Edit Menu)
Use this command to remove a data stream and temporarily store it 
on the clipboard. This command is available only if there is a selected 
data stream. 

Cut File (Edit Menu)
Use this command to remove a file from a data stream and 
temporarily store it on the clipboard. This command is available only 
if there is a selected file. To duplicate a BIT file multiple times, you 
must first cut it, then paste it back to create as many copies as needed. 
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Exit (File Menu)
Use this command to exit from the PROM File Formatter program. If 
you are in the process of creating a PROM file, the program prompts 
you to save the current data. 

New (File Menu)
Use this command to clear the data currently loaded in the 
Configuration Data Stream box located on the PROM File Formatter 
main window. 

Figure 5-2 New Toolbar Button 

Once you have removed the old data from the workspace, you can 
start building a new PROM file. If you click on New while you are in 
the process of creating a data stream, a warning message informs you 
that the current data will be lost.

Paste Data Stream (Edit Menu)
Use this command to insert the cut data stream into the 
Configuration Data Stream box. If there is a selected data stream, the 
command prompts you to paste either before or after the selected 
data stream. 

● Before Selected

Click on this option to paste the data stream that is on the 
clipboard before the selected data stream.

● After Selected

Click on this option to paste the data stream that is on the 
clipboard after the selected data stream.

Paste File (Edit Menu)
Use this command to paste the file that is on the clipboard into the 
Configuration Data Stream box. If there is a selected file, the 
command prompts you to either paste before or after the selected file. 
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● Before Selected

Click on this option to paste the file that is on the clipboard before 
the selected file.

● After Selected

Click on this option to paste the file that is on the clipboard after 
the selected file.

Save PROM (File Menu)
After formatting the configuration bitstream, use the Save As 
command to define and save additional settings for the PROM file. 

Figure 5-3 Save PROM Toolbar Button

Save PROM Dialog Box Options

When you select the Save PROM command, the Save PROM dialog 
box is displayed, as shown in Figure 5-4. The Save PROM  dialog box 
allows you to define the type, format, and size of the PROM file for 
use with the selected device.

Additional selection dialog boxes are available from the Save PROM 
dialog box. 

● To invoke the Byte Wide PROM Detailed Setup dialog box, click 
on the Advanced button of the Save PROM dialog box. This 
dialog box allows you to change the start-up addresses and 
loading directions of byte wide PROM files.

● To invoke the Browse dialog box, click on the Browse button of the 
Save PROM dialog box. This dialog box allows you to change the 
name and path of your PROM file. 
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Figure 5-4 Save PROM Dialog Box

The Save PROM dialog box includes the following options:

● PROM Type radio buttons

By default, the Serial radio button is selected. If you are targeting 
byte wide PROMs, click on the Byte Wide radio button. Xilinx 
PROMs are serial devices. 

● File Format list box

Click on the down arrow to view the available formats: TEKHEX, 
MCS-86, EXORmacs, and HEX. If you choose a format that does 
not support the size of your PROM file, the Inadequate Format 
message box is displayed. In this case, you must return to this 
screen and select a different PROM format. 

● PROM Size list box

Click on the down arrow to view available device sizes. The list 
displays the sizes for either serial or byte wide PROMs depending 
on the PROM Type selected. 

Note: The PROM File Formatter automatically selects the smallest 
single PROM that will fit. 
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For a serial PROM, if you select a PROM size smaller than your 
data size, the Invalid PROM Size message box is displayed from 
which you can select either to change the PROM size or to split 
your PROM file. If your data exceeds the size of all available serial 
PROMs, you are prompted to split your PROM file or to cancel the 
save operation. 

If you are targeting a byte wide PROM and the data size is larger 
than the maximum data size that your selected PROM format can 
support, a message box is displayed informing you that the 
PROM format is inadequate for your data size, and you are asked 
to select a different PROM format. 

● Starting Address and Loading Direction boxes

These options are available if you selected the Byte Wide PROM 
type. To change the starting address of your byte wide PROM file, 
type in the Starting Address field. To select the loading direction, 
use the Loading Direction pull-down list box.

If you click on the Advanced button, the Byte Wide PROM 
Detailed Setup dialog box is displayed. It enables you to set the 
Starting Address and Loading Direction for each data stream in 
your PROM file. 

● File Name box

You can change the file name by typing a new file name in the File 
Name box. To change the drive and directory, or to select an 
existing file name, click on the Browse button. The Browse 
command displays the Browse dialog box. 

● OK button

Click on OK to save the PROM file using the name in the File 
Name box. At the same time, a report file with the same file name 
and a .pdr extension is created with information on the PROM. 

The PDR report lists all the data streams and BIT files used to 
construct the PROM file as well as the load direction and PROM 
file splitting information.

If the selected PROM device is smaller than the data size or if the 
specified format is inadequate for the data size, the file cannot be 
saved and an error message is displayed. 
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Byte Wide PROM Detailed Setup Dialog Box Options

Use the Byte Wide PROM Detailed Setup dialog box to specify the 
loading direction and the starting address of multiple data streams in 
a single composite PROM file. Access this window by selecting the 
Byte Wide format on the Save PROM dialog box, and clicking on the 
Advanced button.

Figure 5-5 Byte Wide PROM Detailed Setup Dialog Box

The Byte Wide PROM Detailed Setup dialog box includes the 
following options:

● Data Stream box

Highlight the data stream whose address you need to modify in 
the Data Stream box. Once you have highlighted a data stream, 
the Starting Address and the Loading Direction fields located 
below the list box are activated and can be modified. 

● Starting Address and Loading Direction boxes

Edit the starting address box and select the loading direction as 
needed. 
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● Apply button

Click on this button to update the data stream list box with the 
changes you have made. 

If you choose to define the address and loading direction for only 
the first data stream in the design, the software updates the 
addresses of the subsequent data streams provided these are 
contiguous and have the same loading direction as the first data 
stream. 

● OK button

When you click on the OK button, the software checks for 
overlapping addresses. Data streams that have overlapping 
addresses are highlighted and an error dialog box informs you of 
the problem. 

● Cancel button

If you click on Cancel, the file is closed without saving the new 
starting address and loading direction information. 

Browse Dialog Box Options

When you click on the Browse button on the Save PROM dialog box, 
the Browse dialog box is displayed. Use this dialog box to display a 
list of existing file names and select an existing file name for the 
PROM file.

Figure 5-6 Browse Dialog Box
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The Browse dialog box includes the following options:

● File Name box

The default file name is shown in the File Name box. It is based on 
the file name of the first file in the first data stream, and has the 
appropriate file extension. 

The extension of the file is either MCS, TEK, EXO, or HEX 
depending on the PROM format chosen. 

● Directory 

The directory is the default directory that was chosen at the time 
the data stream was created.

● OK button

Click on OK to return to the Save PROM dialog box to save the 
PROM file using the new name you have selected. 

● Cancel button

Click on Cancel to return to the Save PROM dialog box without 
using the new file name.

Search for Help On (Help Menu)
Use this option to display the Search dialog box from which you can 
locate a particular Help topic.

Split PROM (File Menu)
Use this command to retarget a PROM file to multiple serial PROM 
devices. 

Figure 5-7 Split PROM Toolbar Button

To retarget an existing PROM file, select the Split PROM option 
immediately after invoking the PROM File Formatter. The Select 
PROM File to Split dialog box is displayed. Once you specify the 
name of the PROM file to split. the Split PROM File dialog box is 
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displayed. This dialog box is also displayed if you attempt to save a 
PROM file into a PROM device that is too small. 

Split PROM File Dialog Box Options 

Use this dialog box to retarget a PROM file to multiple serial PROM 
devices. You can only split MCS, TEK, and EXO file formats. This 
function is not available for HEX files.

Figure 5-8 Split PROM File Dialog Box

The Split PROM File dialog box includes the following options:

● Status box

The Status box provides information on the status of the PROM 
file allocation.
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● The Total Number of Bytes box displays the size of the input 
PROM file and represents the total number of bytes to be 
allocated. 

● The Bytes Filled Up box indicates the number of bytes already 
allocated to a device. 

● The Bytes Left box indicates the number of bytes that still need 
to be allocated. 

● Add Options group box

Click on the radio button for one of the following device selection 
methods and select the devices you need:

● Add Selected Device: Adds one instance of the device type that 
you select in the Device list box.

● Complete Using All Devices: Automatically selects the 
minimum number of serial PROMs required to contain the 
data. 

● Complete Using Selected Device: Adds the appropriate 
number of devices of the type you select in the Device list box.

You must click on the Add button to add the selected devices to 
the list of target devices. 

Note: After adding devices manually or automatically, you can edit 
the list of devices in the right-hand column by removing or adding 
additional devices. 

● Device list boxes

The left-hand list box displays the serial PROM list, which 
provides a listing of available PROMs and corresponding PROM 
sizes. The right list box displays the selected PROMs in the order 
in which the PROM is to be formatted. 

● Change File Name box

By default, the name displayed in this box is applied to the PROM 
device you select in the Device list box. 

To change the name of one of the split files, select the 
corresponding PROM part number in the right-hand Device list 
box and then edit the entry displayed in the Change File Name 
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text box. After editing the file name, click on the Apply button. 
The new name appears next to the part number. 

● Save button

The Save button is grayed out until you have allocated all the 
bytes of your PROM file. When you click on the Save button, the 
split files and a PDR report file are saved in the design directory. 

Status Bar (View Menu)
Use this command to display or hide the status bar, located at the 
bottom of the PROM File Formatter window. The status bar provides 
command and processing information.

Toolbar (View Menu)
Use this command to display or hide the toolbar located at the top of 
the PROM File Formatter window. The toolbar displays several 
buttons, which you can use to specify commands directly. Use the 
toolbar as an alternative to the menu commands.  

Figure 5-9 New Toolbar Button

The New button clears data from the Configuration Data Stream 
screen, allowing you to build a new PROM file.

Figure 5-10 Save PROM Toolbar Button

The Save PROM button displays a dialog box that allows you to 
define the PROM settings and save the current data. 

Figure 5-11 Split PROM Toolbar Button
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The Split PROM button displays the Split PROM dialog box that 
allows you to retarget existing PROM files to multiple serial PROMs.

Figure 5-12 Help Toolbar Button

The Help button invokes context-sensitive help. When you click on 
this button, the cursor changes into a large question mark, allowing 
you to select an object, such as a command button or a toolbar icon. 
When you double-click on the Help button, the first page of the 
PROM File Formatter help is displayed. 

Tutorial (Help Menu)
Use this option to invoke the interactive tutorial. Once the tutorial 
page is displayed, follow the instructions on your screen to view 
definitions, procedures, and demonstrations of the procedures. 
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Glossary of Terms  

The following terms are defined to help you understand the PROM 
File Formatter terminology used in this manual.

byte wide PROM
A PROM that is read one byte at a time. Contrast with the serial 
PROM, which is read one bit at a time.

daisy chain
In the context of the PROM File Formatter, a data stream used to 
configure a set of devices that are connected in series such that the 
DOUT pin of a device in the daisy chain is connected to the DIN pin 
of the next device. You can generate a daisy chain data stream by 
concatenating two or more bitstreams together using the PROM File 
Formatter.

data stream
In the context of the PROM File Formatter, a data stream is a 
collection of one or more concatenated BIT files used to implement a 
single user application. To implement multiple applications, 
concatenate data streams — one data stream per application — to 
form a multiple data stream PROM file that allows you to reprogram 
a single FPGA or a daisy chain. 

EXORmacs (Motorola)
A PROM file format supported by the Xilinx tools. Its maximum 
address is 16,777,216. This format supports PROM files of up to (8 x 
16,777,216) = 134,217,728 bits.
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hexadecimal format (HEX)
A simple text dump of the PROM data in HEX format. It has 
unlimited data capacity.

loading direction
The direction in which data is stored on your PROM. In the Up 
direction, the data is stored in ascending order, starting at a low 
address. In the Down direction, the data is stored in descending 
order, starting at a high address. 

MCS-86 (Intel)
An Intel PROM format supported by the Xilinx tools. Its maximum 
address is 1,048,576. This format supports PROM files of up to (8 x 
1,048,576) = 8,388,608 bits.

menu bar
The area located at the top of the PROM File Formatter main window 
that provides access to the menus. It includes the File, Edit, View, and 
Help menus. 

PROM
A programmable read only memory. 

PROM file
A file consisting of one or more BIT files (bitstreams) formatted into a 
standard PROM file format. If generated using the PROM File 
Formatter, the file is formatted in one of three industry-standard 
formats: Intel MCS-86, Tektronics TEKHEX, or Motorola EXORmacs. 
The PROM file includes headers that specify the length of the 
bitstreams, as well as all the framing and control information 
necessary to configure the FPGAs. It can be used to program one or 
more devices. 
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PROM File Formatter
The program used to format one or more bitstreams into an MCS-86, 
TEKHEX, EXORmacs, or HEX format. 

serial PROM
A PROM whose data is read serially, one bit at a time. Contrast with 
byte wide PROM.

status bar
An area located at the bottom of a window that provides information 
about the commands that you are about to select or that are being 
processed.

TEKHEX (Tektronix)
A Tektronix PROM format supported by Xilinx. Its maximum 
address is 65,536. This format supports PROM files of up to (8 x 
65,536) = 524,288 bits.

toolbar
The area located under the menu bar at the top of your window. It 
contains a series of buttons that you click on to execute some of the 
most commonly used commands. These buttons constitute an 
alternative to the menu commands. 

workspace
The workspace is displayed when you open the PROM Formatter. It 
consists of a frame and an empty data stream. Use this space to create 
and format one or more daisy chains into a PROM file. When you 
add files into the data stream, the horizontal arrows indicate the 
order in which the files are concatenated. 
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Keyboard Commands  

Use the following keyboard commands to navigate and select objects 
on the PROM File Formatter screen and to navigate in the Help tool. 

Summary of Keyboard Commands
The following table is a summary of the PROM File Formatter 
keyboard commands.

Table B-1  Keyboard Commands

Key Action

Tab Traverse objects forward and highlight them
Shift-Tab Traverse objects backward and highlight them

Enter Activate a selection button or a highlighted item 
in a list

Delete Delete the selected file or data stream
Arrow keys Scroll up or down inside selection boxes, 

including menus
Alt-Character Select a menu or button on the main screen

Esc Deselect a menu or exit a Help window
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Multiple Configuration Setups  

This appendix describes programming setups that you can use to 
support multiple applications in a system. It covers three possible 
scenarios. 

● Reconfiguring a daisy chain from a serial PROM for multiple 
functions 

● Reconfiguring a single device or daisy chain for multiple 
functions from a parallel EPROM

● Configuring multiple device daisy chains from one parallel 
EPROM

Reconfiguring a Daisy Chain from a Serial PROM
You can download multiple applications to a single device or to a 
daisy chain of multiple devices in master serial mode from a serial 
PROM device. The master serial mode forces you to reconfigure your 
FPGAs with the applications in a fixed sequence, the sequence in 
which the data streams are saved in the FPGA. 

1. Use the PROM File Formatter to build a PROM file that includes a 
separate data stream for each application that you wish to 
implement in the FPGA or daisy chain. Save it in serial PROM 
format. Each data stream will have its own header and length 
count, which the FPGA or daisy chain uses to determine when it 
has read in all the data for a given application. 

2. Burn the PROM file into a serial PROM device using a PROM 
programmer. 

3. If you are configuring a daisy chain, build the daisy chain of 
devices, ensuring you connect the DOUT output of each slave 



PROM File Formatter Reference/User Guide
device to the DIN input of the next device. Refer to the 
connections given in Figure C-1. 

Figure C-1 Reconfiguration Setup for a Daisy Chain (Serial 
PROM)

Note: In the example in Figure C-1, data stream #1 starts at address 
0000 and data stream #2 starts at address 0800. 

4. If you want to configure a single device, connect the serial PROM 
directly to the FPGA; if you want to configure a daisy chain, 
connect the PROM to the master device of the daisy chain. 

5. Power up the daisy chain of devices. 

The PROM’s internal address counters are reset upon power-up. 
The FPGA or daisy chain reads the length count in the first data 
stream and clocks the serial PROM a length count number of 
times to configure the FPGA or daisy chain with the first 
application. At the end of the first configuration cycle, the PROM 
internal address pointer is left pointing to the end of the first data 
stream. 

6. Reconfigure the daisy chain by pulling the PROG pin of XC4000 
and XC5200 devices Low for at least 300 ns; pull the D/P pin Low 
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for at least 6 µs (microseconds) on XC3000, XC3000A, and XC2000 
devices. 

This action causes the FPGA or daisy chain to read the next data 
stream in the PROM. 

7. If the PROM has been configured for active High Reset, you must 
tie the OE/RESET pin to GND; if the PROM has been 
programmed for active Low Reset, tie the OE/RESET pin to VCC. 

Note: Do not use this procedure if there is any chance that your 
system might be reset before you try to reprogram the FPGAs with 
the second configuration. Any accidental system resets can cause the 
PROM’s internal address counter to be reset to 0 also, which makes it 
point back to the first data stream

Reconfiguring a Single Device or Daisy Chain from a 
Parallel PROM

You can program a single device or daisy chain with multiple 
configurations loaded from a parallel PROM. This method allows 
you to select the desired application in any order by selecting the 
appropriate start address. 

Planning the PROM Structure
1. Use the PROM File Formatter to build a PROM file that includes 

one data stream for each daisy chain that needs to be configured.

2. Determine the total number of bytes required for the largest data 
stream.

3. Compute the number of address bits required to address this 
number of bytes. For example, if the size of the largest data stream 
is 25,000 bytes, then 15 address bits are needed to address them.

4. Use the remaining high order bits as the external select bits to 
select the data stream for the desired application. 

Saving the PROM File
1. Select the byte wide PROM format.
PROM File Formatter Reference/User Guide C-3
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2. Click on the Advanced button to select the starting address for 
each data stream. 

3. Select the starting address for each data stream in the PROM file 
such that the desired data stream can be selected out of 2n data 
streams by asserting n address bits. 

For example, if data streams for two (2n=22=4) different 
applications are stored in the PROM, select the starting addresses 
for the two applications such that they differ by two address bits 
(n=2) — typically the two high order bits. 

4. Save the PROM file.

Implementing the Setup
1. Burn the PROM file into a parallel PROM device using a PROM 

programmer. 

2. Connect the components on your board as shown in Figure C-2.

Figure C-2 Reconfiguration Setup for a Daisy Chain (Parallel 
PROM)

3. To control the n address bits, you can use either a microcontroller 
or a state machine implemented in a 22V10 PAL or XC7000 EPLD. 
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4. To reconfigure the daisy chain, pull the PROG pin of XC4000 and 
XC5000 devices Low for at least 300 µs; pull the D/P pin Low for 
at least 6 µs on XC3000, XC3000A, and XC2000 devices. 

Example

This example explains how to use a microcontroller or PAL device to 
configure four daisy chains using four data streams stored on the 
parallel PROM. The largest daisy chain is 12,500 bytes long. 

Because the largest of these daisy chains requires 12,500 bytes of 
configuration bits, 14 address bits are required to address the data 
(214=16,384 bytes). You must use two external selection bits to select 
each of the four data streams individually. Use the two high order 
bits of each data stream starting address for this purpose (bits 14 
and 15). 

Figure C-1 Data Stream Addressing 

To configure the FPGA daisy chain on power-up with the first 
application, the microcontroller/EPLD/PAL must drive the two high 
order address bits to 00 to select data stream #1 for the first 
application. To reconfigure FPGA or daisy chain for application #4, 
drive the two high order address bits to 11 and assert the appropriate 
REPROGRAM signal.

Configuring Multiple Device Daisy Chains from One 
Parallel PROM

Some applications might require that you store the configuration data 
for multiple daisy chains of FPGAs on the same parallel PROM 
device. To implement such a setup, use additional logic to address 

Data Stream Select Bits Starting Address Ending Address

1 00 00 00000000000000 00 11111111111111

2 01 01 00000000000000 01 11111111111111

3 10 10 00000000000000 10 11111111111111

4 11 11 00000000000000 11 11111111111111
PROM File Formatter Reference/User Guide C-5



PROM File Formatter Reference/User Guide
the different daisy chains, to hold all unconfigured daisy chains in 
reset mode, and to tristate the configured daisy chains while another 
chain is being configured.

Planning the PROM Structure
1. Use the PROM File Formatter to build a PROM file that includes 

one data stream for each daisy chain that needs to be configured.

2. Determine the total number of bytes required for the largest data 
stream.

3. Compute the number of address bits required to address this 
number of bytes. For example, if the size of the largest data stream 
is 25,000 bytes, then 15 address bits are needed to address them.

4. Use the remaining high order bits as the external select bits to 
select the data stream for the desired application. 

Saving the PROM File
1. Select the byte wide PROM format.

2. Click on the Advanced button to select the starting address for 
each data stream. 

3. Select the starting address for each data stream in the PROM file 
such that the desired data stream can be selected out of 2n data 
streams by asserting n address bits. 

For example, if data streams for two (2n=21) different applications 
are stored in the PROM, select the starting addresses for the two 
applications such that they differ by only one address bit (n=1) — 
typically the high order address bit. 

4. Save the PROM file.

Implementing the Setup
1. Burn the PROM file into a parallel PROM device using a PROM 

programmer. 

2. Connect the components on your board as shown in Figure C-3. 
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Figure C-3 Configuration Setup for Multiple Device Daisy Chains

3. To control the n address, select bits, you can use either a 
microcontroller or a state machine implemented in a 22V10 PAL 
or XC7000 EPLD. 

4. As each daisy chain is being configured, use the microcontroller or 
the state machine to hold unconfigured daisy chains in reset mode 
by pulling RESET/INIT Low and to tristate the address lines 
leading to all configured daisy chains. 

5. Use the microcontroller to hold the second daisy chain in reset 
mode while you configure the first daisy chain. Keep the second 
daisy chain in Reset mode until the DONE signal of the first daisy 
chain goes High. When the DONE signal goes High, the first daisy 
chain has completed configuration. 

6. When the DONE signal for the first device goes High, the address 
pins of the master device in the first daisy chain must be tristated 
while the second chain is allowed to configure. This step prevents 
contention with the active outputs of the first daisy chain. 
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Example

This example explains how to use a microcontroller or PAL device to 
configure four daisy chains using four data streams stored on the 
parallel PROM. The size of the largest data stream is 2,500 bytes. 

Because the largest of these daisy chains requires 12,500 bytes of 
configuration bits, 14 address bits are required to express the size of 
the data (214=16,384 bytes). You must use two external selection bits 
to select one out of the four data streams. Use the two high order bits 
of each data stream starting address for this purpose. 

Figure C-2 Data Stream Addressing 

1. To configure daisy chain #1 on power-up, the microcontroller or 
PAL must drive the two high order address bits to 00 to select data 
stream #1 for the first application. 

2. Use the microcontroller or PAL to hold the other three 
unconfigured daisy chains in Reset mode by pulling RESET/INIT 
Low. 

To hold an XC3000A device in Reset mode, hold the Reset pin 
Low; for the XC4000 and XC5200 devices, hold the INIT pin Low. 

3. When the DONE pin goes High on the first daisy chain, the daisy 
chain is configured. The microcontroller/EPLD/PAL must 
respond by tristating the address lines leading to the master 
device of the first daisy chain. The controller also drives the 01 
value on the high-order address bits to select the second data 
stream, then releases Reset on the second daisy chain so that it can 
configure. 

4. Repeat the previous step for the third daisy chain after DONE 
goes High on the second daisy chain, this time tristating the 

Data Stream Select Bits Starting Address Ending Address

1 00 00 00000000000000 00 11111111111111

2 01 01 00000000000000 01 11111111111111

3 10 10 00000000000000 10 11111111111111

4 11 11 00000000000000 11 11111111111111
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address pins on both the first and second daisy chain, driving a 
value of 10 on the high order address bits, and releasing the Reset 
on the third daisy chain. 

5. For the fourth daisy chain, after DONE goes High on the third 
daisy chain, tristate the address pins on the first, second, and third 
daisy chains, drive a value of 11 on the high order address bits, 
and release Reset on the fourth daisy chain.
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